Migrating to Microsoft® Windows Server® 2012 and Microsoft SQL Server® 2012 on Dell™ PowerEdge™ R720 servers

A Principled Technologies configuration guide commissioned by Dell Inc.
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table of contents</td>
<td>2</td>
</tr>
<tr>
<td>Introduction</td>
<td>4</td>
</tr>
<tr>
<td>Why consider migrating to SQL Server 2012 on a Dell PowerEdge R720?</td>
<td>5</td>
</tr>
<tr>
<td>Features of the new Dell PowerEdge R720</td>
<td>5</td>
</tr>
<tr>
<td>About Microsoft Windows Server 2012</td>
<td>7</td>
</tr>
<tr>
<td>About Microsoft SQL Server 2012</td>
<td>7</td>
</tr>
<tr>
<td>Consolidation with Dell and Microsoft technology adds features and simplifies your infrastructure</td>
<td>8</td>
</tr>
<tr>
<td>The power of consolidation</td>
<td>8</td>
</tr>
<tr>
<td>What is consolidation?</td>
<td>8</td>
</tr>
<tr>
<td>Why consolidate?</td>
<td>9</td>
</tr>
<tr>
<td>Sizing and baseline performance</td>
<td>10</td>
</tr>
<tr>
<td>We show you how: Preparing for the move</td>
<td>11</td>
</tr>
<tr>
<td>Evaluating your databases</td>
<td>11</td>
</tr>
<tr>
<td>Gathering baseline performance data</td>
<td>12</td>
</tr>
<tr>
<td>Configuring your internal storage</td>
<td>12</td>
</tr>
<tr>
<td>Installing Windows Server 2012 and enabling the Hyper-V role</td>
<td>13</td>
</tr>
<tr>
<td>Creating your virtual machines</td>
<td>15</td>
</tr>
<tr>
<td>Installing SQL Server 2012 on your virtual machines</td>
<td>16</td>
</tr>
<tr>
<td>We show you how: Making the move</td>
<td>19</td>
</tr>
<tr>
<td>Upgrade Advisor makes it easy</td>
<td>19</td>
</tr>
<tr>
<td>Side-by-side migration</td>
<td>22</td>
</tr>
<tr>
<td>Moving your SQL Server 2005 database: performing the backup</td>
<td>22</td>
</tr>
<tr>
<td>Restoring your database to the SQL Server 2012 virtual machine</td>
<td>23</td>
</tr>
<tr>
<td>We show you how: After the move</td>
<td>24</td>
</tr>
<tr>
<td>Logins and dependencies</td>
<td>24</td>
</tr>
<tr>
<td>Windows and SQL Server logins</td>
<td>24</td>
</tr>
<tr>
<td>SQL Server Agent jobs</td>
<td>26</td>
</tr>
<tr>
<td>Other external dependencies</td>
<td>26</td>
</tr>
<tr>
<td>Summing it all up</td>
<td>27</td>
</tr>
<tr>
<td>Appendix A – Example database survey</td>
<td>28</td>
</tr>
<tr>
<td>Appendix B – Installing windows and enabling Hyper-V</td>
<td>31</td>
</tr>
<tr>
<td>Installing Microsoft Windows Server 2012 Datacenter Edition</td>
<td>31</td>
</tr>
<tr>
<td>Creating new disks in Windows Server 2012 Datacenter Edition</td>
<td>32</td>
</tr>
<tr>
<td>Configuring Windows Update</td>
<td>32</td>
</tr>
<tr>
<td>Adding the Hyper-V role</td>
<td>32</td>
</tr>
<tr>
<td>Appendix C – Creating virtual machines</td>
<td>34</td>
</tr>
<tr>
<td>Appendix D – Installing SQL Server 2012</td>
<td>37</td>
</tr>
<tr>
<td>Appendix E – Installing Upgrade Advisor</td>
<td>39</td>
</tr>
<tr>
<td>Appendix F – Migrating databases</td>
<td>41</td>
</tr>
</tbody>
</table>
INTRODUCTION

New Dell server technology boasts more powerful processors, faster and greater memory capacity, as well as improved and expanded internal storage; all with increased energy efficiency. In addition, breakthroughs in Microsoft virtualization, database and server operating system technologies offer improved operational efficiencies. For these reasons, migrating legacy servers that run older database workloads onto a new virtualized server platform makes sense for companies of all sizes. But how do you upgrade your database software and move your databases without losing information vital to your business while minimizing downtime?

In this guide, we show you how to successfully migrate legacy Microsoft SQL Server 2005 databases running on older servers onto virtual machines (VMs) on a new Dell PowerEdge R720 and update them to reap the benefits of Microsoft SQL Server 2012. From installing Microsoft Windows Server 2012 Hyper-V™, to creating VMs and installing the new database software with SQL Server 2012, replacing and consolidating your current infrastructure with a new server and software solution is a simple, straightforward process.

In addition, we have created two companion reports for this study. The first details the results of our performance tests for this solution, which show that it can consolidate the workloads of eight legacy HP ProLiant DL360 G4p servers while improving performance by an average of 412.4 percent per VM. [http://www.principledtechnologies.com/clients/reports/Dell/R720_Consolidation_Performance_Server2012_SQL2012_1112.pdf](http://www.principledtechnologies.com/clients/reports/Dell/R720_Consolidation_Performance_Server2012_SQL2012_1112.pdf). The second report explains our detailed total cost of ownership (TCO) analysis that shows the savings available through investing in a new
Dell PowerEdge R720 solution to migrate and consolidate your existing infrastructure.


NOTE: Those with more complex configurations, special requirements, or the desire to avoid doing the migration themselves may wish to investigate the consulting services Microsoft and Dell offer.

Why consider migrating to SQL Server 2012 on a Dell PowerEdge R720?

Migrating your databases from older legacy servers to the new Dell PowerEdge R720 running Microsoft Windows Server 2012 and SQL Server 2012 requires some time and planning, but delivers clear benefits. In this section, we present just a few of the benefits that the new Dell PowerEdge R720, Microsoft Windows Server 2012, and Microsoft SQL Server 2012 can provide your business.

Features of the new Dell PowerEdge R720

Figure 1: The new Dell PowerEdge R720 server, powered by the Intel Xeon processor E5-2680.

The new Intel® Xeon® processor E5-2680-powered Dell PowerEdge R720 2U rack server incorporates many enhancements and features designed to improve performance, lower power consumption, and ease maintenance. Some of these features include the following:
**Performance.** Dell engineered the PowerEdge R720 to handle complex workloads, with I/O and internal data management technologies (i.e., NSC, NPAR, CacheCade) to allow faster access to information and GPU accelerators for faster than ever computational performance.

**Processors.** The Dell PowerEdge R720 is powered by two Intel Xeon processors E5-2680, which incorporate the very latest in technology from Intel. The powerful processors provide exceptional performance and make the PowerEdge R720 a solid virtualization platform.

**Power efficiency.** Dell PowerEdge R720 servers implement leading industry power efficiency standards, and are designed to optimize performance while maintaining low power consumption. Automated tracking and regulation of thermal activity, intelligent design of right-sized power options, and high efficiency fans and airflow management work to save power, saving you money in the process.

**Management.** The Dell PowerEdge R720, like all late-model Dell servers, comes with the Dell Lifecycle Controller. This tool simplifies server management by providing a single interface for management functions and by storing critical system information in the system itself. There are no CDs or USB keys to keep track of for drivers or firmware.

**Storage.** With impressive storage capacity for small business servers, the Dell PowerEdge R720 is available in both an 8-bay and 16-bay chassis.

**Memory.** The Dell PowerEdge R720 holds up to 768 GB of RAM, many times the RAM capacity of older small business servers, allowing for powerful flexibility with virtualized database solutions.
About Microsoft Windows Server 2012

Windows Server 2012, the latest release of this server OS from Microsoft, includes many new features and enhancements. According to Microsoft, Windows Server 2012 focuses on four core areas:

- **Beyond virtualization.** Windows Server 2012 provides a robust and dynamic virtualization platform through Hyper-V, and includes new features that provide flexible options for delivering cloud services.
- **The power of many servers, the simplicity of one.** Windows Server 2012 offers improvements in its features that allow for better-than-ever high availability and ease of management for multiple-server infrastructures.
- **Every app, any cloud.** Windows Server 2012 delivers a scalable and flexible Web and application platform by providing a consistent and open set of tools and frameworks that apply to applications on-premises, in the cloud, or in a hybrid environment.
- **Modern work style, enabled.** Microsoft Windows Server 2012 empowers users and IT staff with remote access to data, applications, and simpler management tools while strengthening security and compliance.

About Microsoft SQL Server 2012

SQL Server 2012 is the latest release of Microsoft’s database management platform. Microsoft has added new features to enhance performance, security, and management. SQL Server 2012 introduces Data Quality Services (DQS) to improve the usability of collected data, both locally and from cloud-based data service providers. In addition, SQL Server 2012 is more tightly-integrated with both Microsoft Office client applications and with Microsoft SharePoint® Server, providing greater ease-of-use to users.
CONSOLIDATION WITH DELL AND MICROSOFT TECHNOLOGY ADDS FEATURES AND SIMPLIFIES YOUR INFRASTRUCTURE

In addition to migrating your databases to the new Dell PowerEdge R720, this powerful server allows your organization to also consolidate via virtualization with Microsoft Hyper-V while adding features, improving performance, and realizing savings simultaneously.

The power of consolidation

What is consolidation?

Generally speaking, consolidation is the process of combining multiple items to make a single, more effective unit. In an IT context, you can consolidate the following:

- **Physical servers.** After a successful server consolidation, all applications should run on fewer servers than before. Ideally, those applications should run at least as well as they did previously and potentially better. In our accompanying performance report,¹ we highlight the dramatic performance gains realized in a sample migration to the Dell PowerEdge R720.

- **Storage.** Depending on your setup, consolidating servers may let you also consolidate storage by moving data from a number of servers to a single large disk storage subsystem in a new server. In the case of the Dell PowerEdge R720, this is possible due to its internal storage capacity – up to 24TB total.

- **Space.** As you consolidate servers, you will likely reduce the number of racks or even the number of locations that house servers.

In this database-specific guide, we address the migration of SQL Server 2005 instances running on a legacy server to a Dell PowerEdge R720 running Windows Server 2012 with Hyper-V, with a SQL Server 2012 database instance inside a virtual machine. As our consolidation performance study shows, this solution successfully consolidated eight of these workloads while delivering superior performance. As we will demonstrate, migrating your legacy database instances is a simple and easy-to-follow process, allowing you to take full advantage of this solution by also consolidating multiple legacy servers onto a single Dell PowerEdge R720 server.

**Why consolidate?**

An effective server consolidation effort has the potential to yield an environment with more consistent management practices and improved reliability, security, and hardware utilization—all while maintaining or exceeding the previous level of application performance.

Consolidation can also yield a variety of cost savings, including:

- **Hardware savings.** Buying, powering, and supporting fewer servers brings obvious savings. Other potential hardware cost savings include the need for fewer racks and network switches: as the number of servers decreases, these costs decrease as well.

- **Maintenance and staff savings.** A consolidated infrastructure offers many opportunities to save on maintenance, support, and staffing. Less hardware and associated equipment means fewer servers that require
security patches, monitoring, and other ongoing maintenance.

- **Reduced support costs.** The cost of a given level of support is typically proportional to the size of the installation. As the number of servers decreases, support costs are also likely to decrease.

- **Power and cooling savings.** Consolidating servers saves power and cooling by using fewer, more efficient systems.

**Sizing and baseline performance**

One key to a successful migration and consolidation is sizing, the process of gathering different performance baselines so you have an approximate set of requirements the new hardware platform must meet. You do this by determining the performance characteristics of existing hardware during normal business operations, and then applying growth and scalability estimates.

Among the potential characteristics to examine on each server are the following:

- Processor utilization
- Typical and heavy load memory requirements of the operating system and applications
- Disk layout
- Database size
- Expected database growth
- Maximum concurrent users
- Types and rates of transactions against the databases

The server you select for consolidation must do more than match the combined capacity of your current servers. It also must have enough excess capacity to still perform well at the end of its expected life span.
The Dell PowerEdge R720 we tested for this guide is a high-performance server that can readily support significant consolidation.

WE SHOW YOU HOW: PREPARING FOR THE MOVE

Our accompanying reports show from performance and cost perspectives why you should migrate and consolidate your older database servers to a single Dell PowerEdge R720 and use new Windows Server 2012 Hyper-V virtualization technologies with the added benefits of SQL Server 2012. In this guide, we address the next question: How to accomplish this? We discuss planning issues, setting up the Dell PowerEdge R720, the actual migration using a simple backup/restore method, and post-migration considerations.

Evaluating your databases

As with any migration and subsequent consolidation, planning is a key element. This is especially true when moving to a virtualized environment. You must be aware of many specific details related to each physical server you target for migration, including the maintenance window in which you will migrate the server to its new environment, the users the move will affect, and the configuration tasks necessary to assimilate the databases into your consolidated environment. A more comprehensive example survey appears in Appendix A. Information to gather before migrating includes the following:

- Windows Server OS version and patch level
- SQL Server version and patch level
- Number of logins on this SQL Server instance, and what type of logins these are (Windows or SQL)
- Current backup strategy and schedule for the databases on this server
- Replication details for this SQL instance, if any
After moving your databases to their new SQL Server instance, you must make sure that any system or application using the database has updated connection information. This includes logins, permissions, applications, SQL Server Agent jobs, third-party backup products, and so on.

**Gathering baseline performance data**

During your research phase, you should use Windows® Performance Monitor, SQL Server Profiler, and other tools to gather data on the typical query load and performance statistics on the databases you are considering moving to the new environment. This effort serves two purposes. First, it provides a prime opportunity to identify potential problems before you move to a consolidated solution. Second, you can use the information you gather to map out your resource allocation needs, which you can then use to configure your new virtual machines, either by using different memory allocations, or by allocating differing numbers of virtual CPUs on the virtual machines.

**Configuring your internal storage**

In our test bed, we used only internal storage on the Dell PowerEdge R720, as this adequately served our scenario and our upgrade path. The Dell PowerEdge R720 offers up to 24TB of internal storage, which is likely a huge storage capacity boost for many small businesses. This section provides an overview of the setup of the internal storage configuration on the Dell PowerEdge R720. Please note that we assume you are configuring your server from scratch in order to customize your RAID configuration as well. For our
consolidation performance testing, we created two virtual drives, a 4-HDD RAID 10 virtual drive for the host operating system, VM operating systems, and SQL Server log files, and a 12-HDD RAID 10 virtual drive for the SQL database files.

1. Power on the Dell PowerEdge R720, and press Ctrl+R to enter the PERC BIOS Configuration Utility when the system prompts you during boot. Select the internal RAID controller if offered the choice.
2. Highlight the controller, and press F2 to view your options. Choose to create a new virtual disk.
3. Select the relevant disks and the RAID level required for your scenario. Use the Tab key to navigate through the available options. Highlight OK, and press Enter to complete the virtual disk creation process.
4. We recommend completely initializing the new volume after creation. Highlight the volume by pressing F2, choose Full initialization, and begin the initialization.
5. After the installation completes, press Escape to exit the PERC BIOS Configuration Utility, and press Ctrl+Alt+Delete to reboot the system.

**Installing Windows Server 2012 and enabling the Hyper-V role**

After you configure the internal storage on the Dell PowerEdge R720, you must install the operating system, in this case, Windows Server 2012. Prior to enabling the Hyper-V role, you will need to ensure that Intel Virtualization Technology is enabled on your server. We installed Windows Server 2012 with all the default options, as this provides a robust out-of-the-box solution for most businesses. With the new and improved Server Manager feature, you can easily add Roles and Features to your installation after the initial configuration, if necessary. Below, we provide an overview of the
steps required to install the operating system. For detailed steps, see Appendix B.

1. Insert the Windows Server 2012 DVD media into the DVD drive of the Dell PowerEdge R720 server.

2. By default, the server will boot to the DVD drive. If not, you can force the server to boot to the DVD drive by selecting F11 for the one-time boot option prompt.

3. Choose your language, select your edition, select your drive and partition options, and click Next to complete the installation (see Figure 2). The server will reboot during the installation process.

![Image of Windows Setup screen](image)

Figure 2: Choosing your edition in the Windows Server 2012 installation.

4. After the operating system installation completes, start the Server Manager.

5. Open Disk Management and format any additional volumes as needed.

6. Check for any available Windows updates.
7. Choose to add the Hyper-V role, and allow the installation process to continue.

Creating your virtual machines

To complete your preparation for your SQL Server installation in your new virtualized environment, you must finally create virtual machines on which to run the database software. Here, we provide an overview of the steps required to create your first virtual machine using Hyper-V Manager. For detailed steps on this process, see Appendix C.

1. Launch Server Manager, click Tools, and click Hyper-V Manager.
2. Create a new VM, assigning four virtual processors and 6GB of RAM, and create a 30GB virtual hard drive for the operating system to be installed on. Create additional virtual hard drives as needed. You may vary your resource allocations, such as virtual processors and RAM amounts, based on your specific needs. See Figure 3 for an example of the VM properties screen.
3. Insert the Windows Server 2012 installation media, and attach the physical media to the VM.
Figure 3. Virtual machine configuration in Hyper-V.

Installing SQL Server 2012 on your virtual machines

After you create your virtual machines, install SQL Server 2012 on each VM. It is recommended to deploy SQL Server 2012 to machines or VMs that are joined to an Active Directory® domain. When deploying SQL Server in a domain, do not make the SQL Server service domain accounts members of the Domain Administrators group; grant only the necessary rights on the local server to the SQL Server service account as part of your pre-installation planning. Finally, deploying SQL Server 2012 within a domain greatly simplifies the transfer process for logins in SQL Server.
This section provides an overview of the SQL Server 2012 installation process. Appendix D provides detailed installation instructions.

1. Insert the SQL Server 2012 DVD into the host machine DVD drive, mount it to the virtual machine, and log into the VM.

2. On the SQL Server Installation Center screen, choose Installation in the left pane, and click the link for New SQL Server stand-alone installation or add features to an existing installation in the right pane (see Figure 4).

![Figure 4: SQL Server 2012 Installation Center options.](image)

3. Proceed through the first several installation steps, entering license information and installing prerequisites with default options specified. On the Setup Role screen, choose SQL Server Feature Installation.

4. On the Feature Selection screen, select only what you need for your particular configuration (see Figure 5). We chose the

Figure 5: Choosing features for installation.

5. On the first installation, choose to install the default instance. If you perform subsequent installations on the same server, choose Named Instance and provide a name for the instance.

6. Configure the credentials of the SQL Server service account and SQL Server Agent accounts.

7. Specify SQL Server administrators and a password for the system administrator account, and specify the authentication mode for your configuration. For our configuration, we selected Mixed Mode authentication.

8. Complete the installation.
WE SHOW YOU HOW: MAKING THE MOVE

Upgrade Advisor makes it easy

The SQL Server 2012 Upgrade Advisor is a major aid in migration research. This utility, which the SQL Server 2012 setup wizard includes, scans legacy databases and SQL Server components for compatibility issues, features, and syntax the newer DBMS does not support, as well as many other critical components. The utility lets you view reports quickly in the Upgrade Advisor interface or save reports for later review.

You can install and execute the Upgrade Advisor on machines running Windows XP SP2 or greater, Windows Vista® SP1, Windows 7, Windows Server 2003 SP2, Windows Server 2008 SP2, Windows Server 2008 R2, or Windows Server 2012. The Microsoft .NET™ framework is also a requirement.

BEST PRACTICE: Use the Upgrade Advisor tool on your SQL Server 2005 databases and import a trace file to the Upgrade Advisor tool for analysis. The trace file lets the Upgrade Advisor detect issues that might not show up in a simple scan of the database, such as TSQL embedded in applications. Your migration research and planning must account for such instances. You can capture traces of TSQL using SQL Server Profiler on your SQL Server 2005 servers during typical usage hours and analyze these traces using the Upgrade Advisor.

To install the Upgrade Advisor, use the following steps:

1. Insert the SQL Server 2012 DVD. Click the Planning link, and click Install SQL Server Upgrade Advisor.
2. Click Next to begin the installation wizard, accept the licensing terms, and click Next.
3. Click Next to accept the default Registration information, click Next to accept the default installation path, and click Next to begin the installation.
Once you have installed the SQL Server 2012 Upgrade Advisor, you can use this software to scan your SQL Server 2005 instances for potential migration issues. This section provides a brief walkthrough; Appendix E gives more detailed instructions.

1. Launch the SQL Server 2012 Upgrade Advisor.
2. Click the Launch Upgrade Advisor Analysis Wizard link, and click Next to begin.
3. Enter the older SQL Server computer name, and click Detect to have the Upgrade Advisor remotely scan the older SQL Server machine and detect which components are running on the server. (See Figure 6.)

![Upgrade Advisor component selection](image)

Figure 6: Upgrade Advisor component selection.
4. Choose your instance, provide proper authentication to the older SQL Server if needed, and select the database you want to analyze. If necessary, you can also input SQL script files and trace files here.

5. Following the analysis of your older SQL Server instance, you can view the Upgrade Advisor report, which lists warnings and errors. Each warning or error will have associated information to solve the issue. (See Figure 7.)

Figure 7: Sample Upgrade Advisor output report.
NOTE: If your SQL Server 2005 database uses the Full-Text Search feature, there are additional considerations you may need to take when planning your upgrade, as this feature changed beginning with SQL Server 2008. For more information on this, see http://msdn.microsoft.com/en-us/library/ms142490.aspx.

Side-by-side migration

In this section, we provide an overview of the processes involved in migrating your database from SQL Server 2005 to a virtualized SQL Server 2012 environment on the Dell PowerEdge R720. We provide detailed instructions in Appendix F.

We performed all administrative tasks for the SQL Server 2005 and SQL Server 2012 installations using SQL Server Management Studio, the main administration interface for those versions.

NOTE: Various methods exist for migrating databases between instances and versions of SQL Server, including detach/attach, backup/restore, and the copy database wizard. We chose to use the backup/restore method because most businesses will have a backup routine in place, and administrators will be familiar with the process.

Moving your SQL Server 2005 database: performing the backup

Using the SQL Server 2005 server, take the following steps to back up your database. Backup times vary. Again, note that you must do any special planning in advance to minimize your downtime window.

1. To keep users from issuing updates during the migration process, you can either set the database to read-only mode or set the access property to SINGLE_USER. Both choices immediately sever all user connections. See Appendix F for details on setting the database to single-user mode.

2. Perform a full backup of your SQL Server 2005 database, as we did in Figure 8. See Appendix F for details.
**NOTE:** If the time a full backup requires is unacceptable given your migration maintenance schedule, you can take the full backup at a previously scheduled time, and at this point of the migration take only a differential or transaction log backup. If the transaction log size is small relative to the data file size, this approach can decrease migration time significantly. If you go this route, be certain to keep your backup chain intact.

**Restoring your database to the SQL Server 2012 virtual machine**

On the SQL Server 2012 VM, take the following steps:

1. Open the virtual machine console, and log into the virtual machine.
2. Open SQL Server Management Studio, connect to the SQL Server 2012 instance, and restore the database. (Restore times vary.) See Appendix F for details.
NOTE: At this step, you must give your new database the same name as your SQL Server 2005 database. Changing the name could break applications that refer to the database by name.

3. While in SQL Server Management Studio, reset the database access property to multi-user, and set the compatibility level to SQL 2012 (level 110). See Appendix F for details.

4. Modify application connection strings or change Domain Name System (DNS) pointers that reference the migrated database.

WE SHOW YOU HOW: AFTER THE MOVE

After you have completed your side-by-side migration, you typically need to perform some post-migration tasks. Your specific list of tasks will depend heavily on your pre-migration research and planning. In this section, we briefly discuss several of the most common tasks.

Logins and dependencies

Windows and SQL Server logins

As in previous versions of SQL Server, there are two methods of authenticating to SQL Server 2012: Windows logins and SQL Server logins. You create and administer Windows logins at either the operating system level or the Active Directory domain level, and you can assign those logins’ rights to SQL Server resources. You create and manage SQL Server logins, however, within SQL Server. The processes for extracting login information and creating the transferred login entities on the migration server is very similar for both Windows-authenticated and SQL Server-authenticated logins. There are a few extra steps required to ensure a smooth migration for SQL Server logins.
Below, we describe how to script domain-based Windows-authenticated logins and SQL Server-authenticated logins to a query window and recreate them on the new SQL Server 2012 virtual machine.

Please see Appendix G for details on transferring domain-based Windows logins and Appendix H for details on transferring SQL Server logins. For additional information on transferring Windows-authenticated logins, including more information on SIDs, please visit http://support.microsoft.com/kb/918992.

To transfer logins, take the following steps on the SQL Server 2012 virtual machine. Note that steps 1 through 6 apply to both Windows logins and SQL Server logins, while Step 7 refers solely to SQL Server logins.

1. Log into the virtual machine.
2. In SQL Server Management Studio, in the Object Explorer pane, connect to both your SQL Server 2005 server and your SQL Server 2012 virtual server. Be sure to have the Object Explorer Details tab open (View → Object Explorer Details).
3. Expand the tree view of the SQL Server 2005 server, browse to the Security tab, and click the Logins node. In the Object Explorer Details, you will now see a list of all logins on the SQL Server 2005 server.
4. If necessary, use the sorting and filtering options in the Object Explorer Details tab, and take note of which logins you would like to migrate. Select them by clicking; use the standard Windows controls (Ctrl key, Shift key, etc.) to select multiple logins.
5. Right-click the logins you selected, and choose Script Login As → Create To → New Query Window. Be sure to change the connection of this new query window to connect to your new SQL Server 2012 virtual server by right-clicking and selecting Change Connection.
6. Execute the script on your SQL Server 2012 virtual server to create the logins. If you are transferring Windows-based logins, the process is complete. If you are transferring SQL Server logins, continue with Step 7.

7. For SQL Server logins, the script you executed in Step 6 creates the login, marks it as disabled, and assigns it a random password, but the script does not map the login to the database user. To avoid having a database user that is “orphaned” from a login, use the sp_change_users_login stored procedure, to view orphaned users and to map a user to a login.

**SQL Server Agent jobs**

Almost all installations schedule SQL Server Agent jobs that run against their databases, such as backups, index rebuilds, and other maintenance items. You must migrate these jobs to your new SQL Server 2012 virtual machine. Log into the virtual machine, open SQL Server Management Studio, and connect to your older SQL Server 2005 server. Locate the jobs you need to migrate in SQL Server Management Studio (on your SQL Server 2005 server) under the SQL Server Agent, right-click them, and choose Script Job As→Create To→New Query Window. Connect to the SQL Server 2012 virtual server, and run the resulting script in a query window. Verify the job was created successfully in SQL Server Management Studio.

**Other external dependencies**

Your pre-migration research may well have yielded a list of items for you to implement now; the list might include references to local or remote file shares, database mail or SQL Mail configurations, stored procedures in system databases, and/or linked servers. Addressing these external dependencies will ensure a smooth finish to your migration.
SUMMING IT ALL UP


With careful planning, and by following the straightforward process that this guide presents, you can realize the benefits of switching to your new server-and-software solution in no time.
APPENDIX A – EXAMPLE DATABASE SURVEY

In this appendix, we provide an example survey of detailed information you may want to gather about the SQL Server instances and databases you are targeting for consolidation. While this survey is a good starting point, it may not contain every relevant detail for your particular environment.

1. Hardware level
   a. CPU
      i. Vendor
      ii. Model
      iii. Number of cores per socket
   b. Memory
      i. Total quantity in GB
      ii. Memory speed
   c. Storage
      i. Quantity, both current and projected growth
      ii. Disk speed
      iii. Repository type (Fibre Channel SAN, iSCSI SAN, SCSI direct-attached)
      iv. Disk interface (SCSI, SAS, etc.)

1. OS level
   a. Server name
   b. IP address, subnet, etc.
   c. Domain information
   d. Operating system version, build number, and service pack
   e. Drive letter information and layout

2. SQL Server instance level
   a. Whether it’s clustered, version, edition (Workgroup, Standard, Enterprise), 64-bit or 32-bit (and if 32-bit, with or without AWE), and service pack level
   b. Authentication mode (Windows only or Mixed Mode)
c. Instance name (if not a default instance)

d. SQL port number (e.g., is it the default 1433 or another port? If a named instance, what is the port?)

e. Communication protocol (named pipes or TCP/IP)

f. Service account and all service permission information (does SQL Server Agent run under a different service account?)

g. Are there any non-default master or model database objects?

h. Are there any linked server objects?

i. Are other SQL modules involved or dependent on this instance (e.g., Analysis Services, Reporting Services, etc.)?

j. Default installation directories, data directories, and log directories

k. Tempdb – highly volatile? Slightly volatile? Medium usage?

3. Database level

a. Database properties and options
   i. Recovery model, auto-shrink, etc.
   ii. Files and filegroups (size and location)

b. Backups
   i. How many full backups, and on what schedule?
   ii. How many differential backups, and on what schedule?
   iii. How many log backups, and on what schedule?
   iv. Current backup window?
   v. Can backup window shift to accommodate the consolidated backup window?

c. Other database issues
   i. Is this database in a replication configuration?
   ii. Is this database a partner in a mirroring session?
   iii. Do any SSIS/DTS packages reference this database?
   iv. Do any SQL Server Agent jobs reference this database?
d. Users/Logins
   i. Number of users this database affects
   ii. Would this database require a login whose name conflicts with another name on the target consolidation server? If so, you would need to create the login and map the database user using `sp_change_users_login`
APPENDIX B – INSTALLING WINDOWS AND ENABLING HYPER-V

We installed Windows Server 2012 Datacenter Edition on the Dell PowerEdge R720 with all default options. You may wish to perform additional preparation steps as part of your specific environment, such as standardizing the machine name, enabling certain firewall ports, and so on.

Installing Microsoft Windows Server 2012 Datacenter Edition

1. Insert the installation media into the CD/DVD drive, and restart the server.
2. When the option appears, press F11 to enter the Boot Manager.
3. Select BIOS Boot Menu.
4. Select SATA Optical Drive, and press Enter.
5. Press any key when prompted to boot from DVD.
6. When the installation screen appears, click My language is English (United States).
7. Leave language, time/currency format and input method as default, and click Next.
8. Click Install now.
9. When the installation prompts you, enter the product key.
10. Select Windows Server 2012 Datacenter (Server with a GUI), and click Next.
11. Check I accept the license terms, and click Next.
12. Click Custom: Install Windows only (advanced).
13. Press Alt+A to open advanced partition options. Delete any partitions until there is only Drive 0 Unallocated Space. If you created an additional virtual disk for your SQL databases, this will show up as Drive 1 Unallocated Space.
14. Select Drive 0 Unallocated Space, and click Next, at which point Windows begins automatically, and restarts automatically after completing.
15. When the Settings page appears, fill in the Password and Reenter Password fields with the same password.
16. Log in with the password you set up previously.

Creating new disks in Windows Server 2012 Datacenter Edition

1. In the Server Manager window, click Tools, and click Computer Management.
2. In the left pane, click Disk Management.
3. Right-click the shaded area, and click New Simple Volume.
4. On the New Simple Volume Wizard that pops up, click Next.
5. Select a size (maximum, in our case), and click Next.
6. Assign a drive letter, and click Next.
7. Select Format this volume with the following settings, and leave the default settings. Click Next.
8. Click Finish.

Configuring Windows Update

1. In the left pane of the Server Manager window, click Local Server.
2. In the main frame, next to Windows Update, click Not configured.
3. In the Windows Update window, in the main pane, click Let me choose my settings.
4. Under Important updates, select Never check for updates (not recommended), and click OK.
5. In the left pane, click Check for updates, and install all available updates.

Adding the Hyper-V role

1. In Server Manager, click Manage→Add Roles and Features.
2. At the Before you begin screen, click Next.
3. At the Select installation type, leave the default selection of Role-based or feature-based installation, and click Next.
4. At the Select destination server screen, leave the default selection, and click Next.
5. At the Select server roles screen, check the box for Hyper-V, and click Next.
6. When the Add Roles and Features Wizard window pops up, click Add Features.
7. Click Next.
8. At the Select features screen, click Next.
9. At the Hyper-V screen, click Next.
10. At the Create Virtual Switches screen, select the appropriate NIC, and click Next.
11. At the Virtual Machine Migration screen, leave the checkbox unselected, and click Next.
12. At the Default Stores screen, leave the default locations, and click Next.
13. At the Confirm installation selections screen, check Restart the destination server automatically if required, and click Install.
14. When the installation completes, click Close.
APPENDIX C – CREATING VIRTUAL MACHINES

We created eight VMs running Windows Server 2012, giving each VM four logical processors and 6GB RAM. We used the virtual disk settings in Figure 9 for our test VMs on the Dell PowerEdge R720.

<table>
<thead>
<tr>
<th>Dell PowerEdge R720 VM virtual disk settings</th>
<th>Host volume</th>
<th>Size (GB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>OS.vhdx</td>
<td>C:</td>
<td>30</td>
</tr>
<tr>
<td>SQLData.vhdx</td>
<td>E:</td>
<td>50</td>
</tr>
<tr>
<td>SQLLog.vhdx</td>
<td>C:</td>
<td>20</td>
</tr>
</tbody>
</table>

Figure 9: The virtual disk settings we used.

Below, we provide detailed steps on creating your virtual machines using Hyper-V manager. Note that drive availability and required number of VHDX files may vary based on your environment.

1. Launch Server Manager, and click Tools→Hyper-V Manager.
2. From the Action menu, select New→Connect to Server...
3. In the Select Computer dialog, select Local Computer, and click OK.
4. From the Action menu, select New→Hard Disk.
5. In the New Virtual Hard Disk wizard, click Next.
6. On the Choose Disk Format screen, choose VHDX format, and click Next.
7. On the Choose Disk Type screen, choose Fixed Size, and click Next.
8. On the Specify Name and Location screen, give the virtual drive a name, specify its location, and click Next.
9. On the Configure Disk screen, select Create a new blank virtual hard disk, assign 30GB for size, place the VHD in the appropriate folder on the server, and click Next.
10. Repeat Step 9 for the remaining VHDs necessary for your VMs. For flexibility on our SQL Server VMs, we created a separate virtual hard drive for the OS, a virtual hard drive for SQL Server data, and a virtual hard drive for SQL Server logs. You may also want to configure additional virtual hard drives for backup and utility files.
11. From the Action menu, select New→Virtual Machine.
13. On the Specify Name and Location page, enter the name for your new virtual machine, and click Next.
14. On the Assign Memory page, enter the RAM amount.
15. On the Configure Networking, choose the network assigned to VM traffic, and click Next.
16. Choose to add a virtual hard disk later.
17. On the Installation Options page, accept the default of Install an operating system later, and click Next.
19. Right-click the virtual machine, and choose Settings.
20. Click Processors, and choose the number of virtual processors. We chose four virtual processors for our database virtual machines.
21. Click the virtual IDE controller 0.
22. Click Add, and click Hard Drive.
23. Browse to the first VHDX you created in Step 4, and choose that VHDX for the guest OS VHDX.
24. Click Apply.
25. Click the SCSI controller.
26. Click Add, and click Hard Drive.
27. Browse to the second VHDX you created in Step 10, and choose that VHDX for the SQL Server data VHDX.
28. Click Apply.
29. Repeat steps 25 through 28 for the remaining SQL Server related VHDXs.
30. Power on the VM, and proceed to install Windows Server 2012 on the VM, following the instructions from the above Installing Microsoft Windows Server 2012 section.
31. After Windows Server 2012 is installed on the VM, use the following steps to join it to the same Active Directory domain as the existing SQL Server 2005 server.
a. In Server Manager, click Manage \rightarrow Local Server.
b. Click WORKGROUP.
c. On the Computer Name tab, click Change.
d. Select Member of Domain and fill in the domain name.
e. Click OK.
f. On the Windows Security screen, enter the user name and password of the account with which to log into the domain, and click OK.
g. Click OK to clear Welcome message.
h. Reboot the VM.
APPENDIX D – INSTALLING SQL SERVER 2012

Install an instance of Microsoft SQL Server 2012 by following these steps. This installation walkthrough covers only the installation of the Database Engine and Management Components. For other components outside the scope of this guide, such as Reporting Services, Integration Services, or Analysis Services, see Microsoft documentation at http://msdn.microsoft.com/en-us/library/bb500395.aspx.

Install an instance of Microsoft SQL Server 2012 for each VM by following these steps below.

1. Connect and log into the virtual machine.
2. Insert the installation DVD for SQL Server 2012 into the DVD drive and attach it to the virtual machine.
3. Click Run SETUP.EXE. If Autoplay does not begin the installation, navigate to the SQL Server 2012 DVD, and double-click it.
4. In the left pane, click Installation.
5. Click New SQL Server stand-alone installation or add features to an existing installation.
6. At the Setup Support Rules screen, wait for the check to complete. If there are no failures or relevant warnings, click OK.
7. Select the Enter the product key radio button, and enter the product key. Click Next.
8. Click the checkbox to accept the license terms, and click Next.
9. Click Install to install the setup support files.
10. If there are no failures displayed, click Next.
11. At the Setup Role screen, choose SQL Server Feature Installation.
13. At the Installation Rules screen, after the check completes, click Next.

14. At the Instance configuration screen, leave the default selection of default instance, and click Next.

15. At the Disk space requirements screen, click Next.

16. At the Server Configuration screen, choose NT Service\SQLSERVERAGENT for SQL Server Agent, and choose NT Service\MSSQLSERVER for SQL Server Database Engine. Click Next.

17. At the Database Engine Configuration screen, select the authentication method you prefer. For our testing purposes, we selected Mixed Mode.

18. Enter and confirm a password for the system administrator account.

19. Click Add Current user. This may take several seconds.

20. Click Next.

21. At the Error and usage reporting screen, click Next.

22. At the Installation Configuration Rules screen, check that there are no failures or relevant warnings, and click Next.

23. At the Ready to Install screen, click Install.


25. Close the installation window.
APPENDIX E – INSTALLING UPGRADE ADVISOR

In this appendix, we walk through the steps to install and run the SQL Server 2012 Upgrade Advisor and save Upgrade Advisor reports.

1. Insert the SQL Server 2012 DVD to the machine in which you wish to install the Upgrade Advisor. On the Planning screen, click Install SQL Server Upgrade Advisor.
2. Click Next to begin the installation wizard, accept the licensing terms, and click Next.
3. Click Next to accept the default Registration information, click Next to accept the default installation path, and click Next to begin the installation.
4. At the Completing the Microsoft SQL Server 2012 Upgrade Advisor screen, click Finish to exit the setup.
5. Start the Upgrade Advisor by selecting Launch the Upgrade Advisor.
6. Click the Launch Upgrade Advisor Analysis Wizard link.
7. At the Welcome screen, click Next.
8. On the SQL Server Components screen, by default the Upgrade Advisor populates the server name field with the local computer name. Replace this with the computer name or IP address of the SQL Server you want to analyze, and click Detect to allow the Upgrade Advisor to scan the components on the SQL Server instance you specified. The Upgrade Advisor automatically selects the components installed on the legacy server.
9. Click Next.
10. On the Connection Parameters screen, the Upgrade Advisor will have filled in the necessary information if you are using Windows authentication. If you are using SQL authentication, you will need to enter the appropriate credentials. Click Next.
11. On the SQL Server parameters screen, the Upgrade Advisor will have filled in the necessary information. Click Next.
12. On the Confirm Upgrade Advisor Settings screen, review your choices, and click Run.
13. When the analysis completes, click Launch Report to view the analysis report.
14. You can now use the drop-down filter tools to view report items by component or by issue severity.

NOTE: If you want to export the report, click Export Report in the lower right corner of the Upgrade Advisor interface.
APPENDIX F – MIGRATING DATABASES

In this appendix, we give detailed instructions about a basic side-by-side migration of a user database from a SQL Server 2005 server to a SQL Server 2012 VM. There are multiple methods of accomplishing this task, including using TSQL commands and automated tools. Here, we discuss performing the database migration using the graphical interface tools Microsoft provides with SQL Server 2005 and SQL Server 2012.

Back up a SQL Server 2005 database

1. Log into Windows on the SQL Server 2005 server as either an administrative user or a user with full rights on SQL Server 2005.

2. Start SQL Server Management Studio by selecting Start → All Programs → Microsoft SQL Server 2005 → SQL Server Management Studio.

3. Enter your server name, and select Windows Authentication.

4. Set the database to single-user mode to ensure no updates occur.

5. To set the database to single-user mode, in Object Explorer, right-click the database, and choose Properties.

6. Click Options, and scroll to the State section.

7. For the Restrict Access setting, choose SINGLE_USER, and click OK. Click Yes when prompted that other connections will be cut off.

8. Right-click the database, and choose Tasks, Back Up.

9. Click Add… to add a backup device, and click the “…” button to browse to the backup location you want to use. Select a folder,
and enter a filename, such as DatabaseNameMigrationBackup.bak.

10. Click OK to close the Backup Device Location window, and click OK to close the Select Backup Destination window.

**NOTE:** To simplify moving the database later, we recommend creating the backup in a shared local folder.

11. Optionally, on the Options tab, select the checkbox to verify your database backup upon completion.

**NOTE:** This option increases backup time but checks the integrity of the backup file. We chose to verify the backup.

12. Click OK to begin the SQL Server 2005 database backup. (Backup times vary with database size and backup device configuration.)

13. To clear the completion message, click OK.

14. After the backup completes, in SQL Server Management Studio, under Databases, right-click the database, and choose Tasks→Take Offline.

15. To clear the confirmation message, click Close. The old database is now offline, so SQL Server 2005 will not allow any connections to it.


**Restoring a database to SQL Server 2012**

1. Transfer your SQL Server 2005 database backup file to the virtual machine.

2. Log into Windows on the SQL Server 2012 VM.

3. In Windows Explorer, navigate to the backup folder location.

4. Launch SQL Server Management Studio.

5. Select Database Engine for Server type, and type the server name in Server name. For Authentication, we used Windows Authentication.
6. In the Object Explorer pane, right-click Databases, and select Restore Database.
7. For the Source, select Device, and click the “…” button.
8. In the Select backup devices section, select File for the backup media type.
9. Click Add, and enter the full path to the database backup.
10. Click OK.
11. SQL Server will fill in the information in the To section of the Restore Database screen.

**NOTE:** It is critical to have the same database name as on your SQL Server 2005 server. If the database name does not match, applications that depend on the database name may break.

12. To return to the Restore Database window, click OK.
13. Select the checkbox that now appears in the Restore column. Optionally, click Options on the left, and ensure the file locations are appropriate in the Restore As column.

**NOTE:** In your new virtual machine, your storage layout may differ significantly from your older physical machine. Modify the file layout on the Options screen as necessary.

14. To begin the restore, click OK. Note the progress indicator in the upper right of the Restore window. (Restore time varies with database size and server and with disk subsystem speed.)
15. Click OK to clear the confirmation message.
16. After the restore is complete, you must change the database access state back to multi-user and upgrade the compatibility level by performing the following steps:
   a. Right-click the database in Object Explorer, and select Properties.
   b. On the left side to access database options, click Options.
   c. Change Compatibility level to SQL Server 2012 (110).
d. Scroll down to Restrict Access, and change to 
   MULTI_USER.

e. Click OK.

f. Click Yes to agree to shutting down other connections.
APPENDIX G – TRANSFERRING WINDOWS LOGINS

In this appendix, we provide detailed instructions for transferring Windows-based logins from SQL Server 2005 machine to SQL Server 2012 in an Active Directory environment.

2. On the Connect to Server screen, select Database Engine for the server type, enter the computer name of the legacy server, and click Connect.
3. Select View→Object Explorer Details, to bring up the Object Explorer Details tab.
4. In the Object Explorer pane, expand the Security folder, and highlight the Logins folder.
5. To add the Login Type column to the display, right-click the column-header area in the Object Explorer Details pane and select Login Type. Now Windows Logins appear as Login Type 0. Optionally, use the column headers to sort by Default Database, or use the filter button to find only logins that you are interested in migrating.
6. Using the standard Windows multi-select key combinations (Ctrl key or Shift key), highlight the logins you are interested in migrating.
7. Right-click the highlighted logins, and select Script Login as→Create To→New Query Editor Window.
8. Click the Change Connection button on the SQL Editor toolbar and select the new instance of SQL.
9. To run the resulting script, click Execute.
APPENDIX H – TRANSFERRING SQL SERVER LOGINS

In this appendix, we give detailed instructions on transferring SQL Server logins from a SQL Server 2005 machine to a virtual machine running SQL Server 2012.

1. Launch SQL Server Management Studio.

2. On the Connect to Server screen, select Database Engine for the server type, enter the computer name of the legacy server, and click Connect.

3. Select View→Object Explorer Details, to bring up the Object Explorer Details tab.

4. In the Object Explorer pane, expand the Security folder, and highlight the Logins folder.

5. To add the Login Type column to the display, right-click the column-header area and select Login Type. Now SQL Server Logins appear as Login Type 2. Optionally, use the column headers to sort by Default Database, or the Filter button to find only logins that you are interested in migrating.

6. Using the standard Windows multi-select key combinations (Ctrl key or Shift key), highlight the logins you are interested in migrating.

7. Right-click the highlighted logins, and select Script Login as→Create To→New Query Editor Window.

8. Click the Change Connection button on the SQL Editor toolbar and select the new instance of SQL.

9. Too run the resulting script, click Execute.

Mapping transferred logins to database users

After transferring SQL Server logins from server to server, you must map those logins to the database users that you migrated during the restore process.
**NOTE:** This process assumes that you have already migrated the applicable database to the new server.

1. Right-click the relevant database, and select New Query.

2. Enter the following command, and click Execute:
   
   ```sql
   EXEC sp_change_users_login 'Report';
   ```

3. For each user output from the above step, map these orphaned users to the appropriate matching SQL Server login by taking the following steps:
   
   a. Open a query window on the SQL Server 2012 virtual server using steps 1 through 3 above.
   
   b. For each login you wish to map, enter the following command, and click Execute:
      
      ```sql
      EXEC sp_change_users_login 'Auto_Fix','SQLLogin';
      ```
   
   c. The above command maps the database user “SQLLogin” to the SQL Server login of “SQLLogin”. This procedure assumes that the database user and SQL Server login have the same value.

4. To reset the password and enable the account, enter the following command, and click Execute:
   
   ```sql
   USE [master]
   GO
   
   ALTER LOGIN [SQLLogin] WITH PASSWORD=N'Password1'
   GO
   
   ALTER LOGIN [SQLLogin] ENABLE
   GO
   ```
ABOUT PRINCIPLED TECHNOLOGIES

We provide industry-leading technology assessment and fact-based marketing services. We bring to every assignment extensive experience with and expertise in all aspects of technology testing and analysis, from researching new technologies, to developing new methodologies, to testing with existing and new tools.

When the assessment is complete, we know how to present the results to a broad range of target audiences. We provide our clients with the materials they need, from market-focused data to use in their own collateral to custom sales aids, such as test reports, performance assessments, and white papers. Every document reflects the results of our trusted independent analysis.

We provide customized services that focus on our clients’ individual requirements. Whether the technology involves hardware, software, Web sites, or services, we offer the experience, expertise, and tools to help our clients assess how it will fare against its competition, its performance, its market readiness, and its quality and reliability.

Our founders, Mark L. Van Name and Bill Catchings, have worked together in technology assessment for over 20 years. As journalists, they published over a thousand articles on a wide array of technology subjects. They created and led the Ziff-Davis Benchmark Operation, which developed such industry-standard benchmarks as Ziff Davis Media’s Winstone and WebBench. They founded and led eTesting Labs, and after the acquisition of that company by Lionbridge Technologies were the head and CTO of VeriTest.

Principled Technologies is a registered trademark of Principled Technologies, Inc.
All other product names are the trademarks of their respective owners.

Disclaimer of Warranties; Limitation of Liability:
PRINCIPLED TECHNOLOGIES, INC. HAS MADE REASONABLE EFFORTS TO ENSURE THE ACCURACY AND VALIDITY OF ITS TESTING, HOWEVER, PRINCIPLED TECHNOLOGIES, INC. SPECIFICALLY DISCLAIMS ANY WARRANTY, EXPRESSED OR IMPLIED, RELATING TO THE TEST RESULTS AND ANALYSIS, THEIR ACCURACY, COMPLETENESS OR QUALITY, INCLUDING ANY IMPLIED WARRANTY OF FITNESS FOR ANY PARTICULAR PURPOSE. ALL PERSONS OR ENTITIES RELYING ON THE RESULTS OF ANY TESTING DO SO AT THEIR OWN RISK, AND AGREE THAT PRINCIPLED TECHNOLOGIES, INC., ITS EMPLOYEES AND ITS SUBCONTRACTORS SHALL HAVE NO LIABILITY WHATSOEVER FROM ANY CLAIM OF LOSS OR DAMAGE ON ACCOUNT OF ANY ALLEGED ERROR OR DEFECT IN ANY TESTING PROCEDURE OR RESULT.

IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES, INC. BE LIABLE FOR INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH ITS TESTING, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES, INC.’S LIABILITY, INCLUDING FOR DIRECT DAMAGES, EXCEED THE AMOUNTS PAID IN CONNECTION WITH PRINCIPLED TECHNOLOGIES, INC.’S TESTING. CUSTOMER’S SOLE AND EXCLUSIVE REMEDIES ARE AS SET FORTH HEREIN.